Avaya Merlin Legend DTMF Integration Guide for
Cisco Unity 4.0

Revised March 31, 2006

This document provides instructions for integrating the phone system with Cisco Unity.

Integration Tasks

Before doing the following tasks to integrate Cisco Unity with the Avaya Merlin Legend phone system,
confirm that the Cisco Unity server isready for the integration by completing the applicable tasksin the
applicable Cisco Unity installation guide.

The following task lists describe the process for creating, changing, and deleting integrations.

Task List to Create the Integration

Cisco SYSTEMS

Use the following task list to set up a new integration with the Avaya Merlin Legend phone system. If
you are installing a new Cisco Unity server by using the applicable Cisco Unity installation guide, you
may have already completed some of the following tasks.

1. Review the system and equipment requirements to confirm that all phone system and Cisco Unity
server requirements have been met. See the “ Requirements’ section on page 2.

2. Plan how the voice messaging ports will be used by Cisco Unity. See the “Planning How the Voice
Messaging Ports Will Be Used by Cisco Unity” section on page 4.

3. Program the Avaya Merlin Legend phone system and extensions. See the “ Programming the Avaya
Merlin Legend Phone System” section on page 6.

4, Create the integration. See the “ Creating a New Integration with the Avaya Merlin Legend Phone
System” section on page 8.

5. Test the integration. See the “ Testing the Integration” section on page 11.

6. If you have a secondary server for Cisco Unity failover, integrate the secondary server. See the
“Integrating a Secondary Server for Cisco Unity Failover” section on page 14.
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Task List to Make Changes to an Integration

Use the following task list to make changes to an integration after it has been created.

1. Start the Cisco Unity Telephony Integration Manager (UTIM). See the “ Changing the Settings for
an Existing Integration” section on page 17.

2. Make the changes you want to the existing integration. See the “ Changing the Settings for an
Existing Integration” section on page 17.

Task List to Delete an Existing Integration

Use the following task list to remove an existing integration.

1. Start the Cisco Unity Telephony Integration Manager (UTIM). See the “Deleting an Existing
Integration” section on page 18.

2. Delete the existing integration. See the “Deleting an Existing Integration” section on page 18.

Requirements

The Avaya Merlin Legend integration supports configurations of the following components:

Phone System
- AvayaMerlin Legend, release 7.0.

» Software version 9.0 or later.

» The voice messaging ports in the phone system connected to the voice cards in the Cisco Unity
server.

- The phone system ready for theintegration, as described in the documentation for the phone system.

Cisco Unity Server

- The applicable voice cards, installed. For details, refer to the “ Supported Circuit-Switched Phone
System Integrations” section in your version of Cisco Unity System Requirements at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

» Cisco Unity installed and ready for the integration, as described in the applicable Cisco Unity
installation guide at

http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides list.html.
« A license that enables the appropriate number of voice messaging ports.
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Integration Description

Integration Description

The Avaya Merlin Legend phone system communicates with the Cisco Unity server by using DTMF
sequences. The voice messaging lines from the phone system connect to the analog voice cards in the
Cisco Unity server. Figure 1 shows the required connections for analog connections.

Figure 1 Connections Between the Phone System and Cisco Unity
— =1
=
Phone system Cisco Unity server
Analog lines

Call Information

The phone system sends the following information with forwarded calls:
» The extension of the called party
» The extension of the calling party (for internal calls)

Cisco Unity uses this information to answer the call appropriately. For example, a call forwarded to
Cisco Unity is answered with the personal greeting of the subscriber. If the phone system routes the call
to Cisco Unity without this information, Cisco Unity answers with the opening greeting.

Integration Functionality

The Avaya Merlin Legend integration with Cisco Unity provides the following features:
- Call forward to personal greeting
- CallerID

» Easy message access (a subscriber can retrieve messages without entering an 1D because
Cisco Unity identifies the subscriber based on the extension from which the call originated; a
password may be required)

» ldentified subscriber messaging (Cisco Unity identifies the subscriber who leaves a message during
aforwarded internal call, based on the extension from which the call originated)

» Message waiting indication (MWI)

Integrations with Multiple Phone Systems

Depending on the version, Cisco Unity can be integrated with two or more phone systems:

» Cisco Unity 4.0 and 4.1 can be integrated with a maximum of two phone systems at one time. For
information on and instructions for integrating Cisco Unity with two phone systems, refer to the
Dual Phone System Integration Guide at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/integuid/multi/itmultin.htm.
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- Cisco Unity 4.2 and later can be integrated with two or more phone systems at one time. For
information on the maximum supported combinations and instructions for integrating Cisco Unity
with multiple phone systems, refer to the Multiple Phone System Integration Guide at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/integuid/multi/multcud2.htm.

Planning How the Voice Messaging Ports Will Be Used by
Cisco Unity

Before programming the phone system, you need to plan how the voice messaging ports will be used by
Cisco Unity. The following considerations will affect the programming for the phone system (for
example, setting up the hunt group or call forwarding for the voice messaging ports):

» The number of voice messaging ports installed.
» The number of voice messaging ports that will answer calls.

» The number of voice messaging ports that will only dial out, for example, to send message
notification, to set message waiting indicators (MWIs), to make AMIS deliveries, and to make
telephone record and playback (TRAP) connections.

The following table describes the voice messaging port settingsin Cisco Unity that can be set in UTIM,
and that are displayed as read-only text on the System > Ports page of the Cisco Unity Administrator.

Table 1 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get a
ringing tone but are not answered. Typically, the port is disabled only by the installer during

testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be incoming
calls from unidentified callers or from subscribers.

M essage Notification Check this check box to designate the port for notifying subscribers of messages. Assign
Message Notification to the least busy ports.

Dialout MWI Check this check box to designate the port for turning MWIson and off. Assign Dialout MWI

(not used by serial or SMDI to the least busy ports.
integrations)
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Planning How the Voice Messaging Ports Will Be Used by Cisco Unity Il

Table 1 Settings for the Voice Messaging Ports (continued)

Field Considerations

AMIS Delivery Check this check box to designate the port for making outbound AMIS callsto deliver voice
(available with the AMIS messages from Cisco Unity subscribers to users on another voice messaging system.

Cisco Unity supports the Audio Messaging I nterchange Specification (AMIS) protocol,
which provides an analog mechanism for transferring voice messages between different
Voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

licensed feature only)

Because the transmission of outgoing AMIS messages may tie up voice ports for long
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule
page so that outgoing AMIS calls are placed during closed hours or at times when

Cisco Unity is not processing many calls.

TRAP Connection Check this check box so that subscribers can use the phone as a recording and playback
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the
least busy ports.

The Number of Voice Messaging Ports to Install
The number of voice messaging ports to install depends on numerous factors, including:

» The number of calls Cisco Unity will answer when call traffic is at its peak.

« The expected length of each message that callers will record and that subscribers will listen to.
= The number of subscribers.

» The number of portsthat will be set to dial out only.

» The number of calls made for message notification.

« The number of MWIs that will be activated when call traffic is at its peak.

e The number of AMIS delivery calls.

« The number of TRAP connections needed when call traffic is at its peak. (TRAP connections are
used by Cisco Unity web applications and e-mail clients to play back and record over the phone.)

« Thenumber of callsthat will use the automated attendant and call handlers when call trafficisat its
peak.

It isbest toinstall only the number of voice messaging ports that are needed so that system resources are
not allocated to unused ports.

The Number of Voice Messaging Ports That Will Answer Calls

The calls that the voice messaging ports answer can be incoming calls from unidentified callers or from
subscribers. Typically, the voice messaging ports that answer calls are the busiest.

You can set voice messaging ports to both answer calls and to dial out (for example, to send message
notifications). However, when the voice messaging ports perform more than one function and are very
active (for example, answering many calls), the other functions may be delayed until the voice messaging
port isfree (for example, message notifications cannot be sent until there are fewer callsto answer). For
best performance, dedicate certain voice messaging ports for only answering incoming calls, and
dedicate other ports for only dialing out. Separating these port functions eliminates the possibility of a
collision, in which an incoming call arrives on a port at the same time that Cisco Unity takes the port
off-hook to dial out.

Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0
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The Number of Voice Messaging Ports That Will Only Dial Out, and Not Answer Calls
Ports that will only dial out and will not answer calls can do one or more of the following:

» Notify subscribers by phone, pager, or e-mail of messages that have arrived.
e Turn MWIs on and off for subscriber extensions.

» Make outbound AMIS calls to deliver voice messages from Cisco Unity subscribers to users on
another voice messaging system. (This action is available only with the AMIS licensed feature.)

- Make a TRAP connection so that subscribers can use the phone as a recording and playback device
in Cisco Unity web applications and e-mail clients.

Typically, these voice messaging ports are the least busy ports.

A

Caution  Inprogramming the phone system, do not send calls to voice messaging portsin Cisco Unity that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if avoice messaging
port is set only to Dialout MWI, do not send calls to it.

Preparing for Programming the Phone System

Record your decisions about the voice messaging ports to guide you in programming the phone system.

Programming the Avaya Merlin Legend Phone System

If you use programming options other than those supplied in the following procedure, the performance
of the integration may be affected.

A

Caution  In programming the phone system, do not send calls to voice messaging portsin Cisco Unity that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if avoice messaging
port is set only to Dialout MWI, do not send calls to it.

Do the following procedure.

To Program the Avaya Merlin Legend Phone System

Stepl  On the phone system, create an extension for each voice messaging port.
Step2  Assign the station type I nteg vmi to each voice messaging port.

Step3  On aconsole phone, press the M enu button.

Step4  Pressthe Sys Program button.

Step5  Pressthe Start button.

Step6  Pressthe Extensions button.

Step7  Pressthe More button.

Step8  Pressthe GRP Calling button.

Step9  Pressthe More button.

Step 10  Press the Group Type button.

Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0
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Step 11
Step 12

Step 13
Step 14
Step 15

Step 16
Step 17
Step 18
Step 19
Step 20
Step 21
Step 22

Step 23
Step 24
Step 25
Step 26
Step 27
Step 28
Step 29
Step 30
Step 31
Step 32
Step 33
Step 34
Step 35
Step 36

Step 37

Note

Programming the Avaya Merlin Legend Phone System 1l

Enter the number for your voice mail group (for example, enter 770), and press the Enter button.

The extension assigned as the voice mail group (pilot) number is the extension that subscribers dial to
listen to their voice messages or to forward calls to voice mail.

In the LCD of the console phone, confirm that INTEG VMI is highlighted.

Press the Enter button.

If you do not want to add the voice messaging ports to a coverage group, skip to Step 36.

If you want to use a coverage group, on a console phone, press the M enu button.

Press the Sys Program button.

Press the Start button.

Press the Extensions button.

Press the M or e button.

Press the Group Cover button.

Enter the number for your coverage group (for example, enter 30), and press the Enter button.

Enter the extensions for the Cisco Unity voice messaging ports to the coverage group, and press the
Enter button.

Press the Home button.

Press the M enu button.

Press the Sys Program button.

Press the Start button.

Press the Extensions button.

Press the M or e button.

Press the Group Calling button.

Press the Grpcover age button.

Enter the number of the voice mail group that you created in Step 11 (for example, enter 770).
Press the Enter button.

Enter the number of the coverage group that you created in Step 21 (for example, enter 30).
Press the Enter button.

Press the Home button.

Program each phone to forward calls to the pilot number assigned to the voice messaging ports (for
example, to 770) by using Release transfer (blind transfer) when the extension is busy and when the call
is not answered.

On each subscriber phone, program a speed dial button to dial the pilot number assigned to the voice
messaging ports (for example, to dial 770) so that subscribers can quickly access their messages.

You can use alternate extensions to create multiple line appearances, enable easy message access from
cell phones, and simplify addressing messages to subscribers at different locations in Cisco Unity.
Enabling alternate MWIslets Cisco Unity turn MWIs on at more than one extension. For details, seethe
“Appendix: Using Alternate Extensions and MWIs” section on page 18.

[ oL-5849-03
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Creating a New Integration with the Avaya Merlin Legend
Phone System

Step 1

Step 2
Step 3

Step 4

Step 5
Step 6

Step 7
Step 8

Step 9

Step 10

After ensuring that the Avaya Merlin Legend phone system and the Cisco Unity server are ready for the
integration, do the following procedures to set up the integration and to enter the port settings.

To Create an Integration

If UTIM is not already open, on the Windows Start menu of the Cisco Unity server, click Programs >
Cisco Unity > Manage Integrations. UTIM appears.

In the left pane of the UTIM window, click Cisco Unity Server.

On the Integration menu of the UTIM window, click New. The Telephony Integration Setup Wizard
appears.

On the Welcome page, click the applicable phone system type, depending on your version of
Cisco Unity:

« Cisco Unity 4.2 or later—Circuit-Switched via Voice Cards
» Cisco Unity 4.0 or 4.1—Circuit-Switched (Traditional PBX)
Click Next.

On the Name the Phone System Integration page, accept the default name or enter another name to
identify thisintegration, then click Next.

On the Select Integration Method page, click Analog, then click Next.
On the Select Phone System Manufacturer page, click the following settings, then click Next.

Table 2 Settings for the Select Phone System Manufacturer Page
Field Setting

Manufacturer Avaya

Model Merlin 2

Software Version FP-3

Configuration File <if you have made copies of the .ini configuration file, the name of the
configuration file that you want to use>

On the Enter MW!I Codes page, enter the following settings, then click Next.

Table 3 Settings for the Enter MWI Codes Page

Field Setting

MW!I On Code <the code you specified in the phone system for turning MWIs on>
MWI Off Code <the code you specified in the phone system for turning MWIs off>

On the Set Number of Voice Messaging Ports page, enter the number of voice messaging ports on
Cisco Unity that you want to connect to the phone system, then click Next.

This number cannot be more than the number of ports on theinstalled voice cards or the number of ports
set up on the phone system.

Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0
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Step 11

Step 12

Step 13

Step 14
Step 15

Creating a New Integration with the Avaya Merlin Legend Phone System

If other integrations already exist, the Enter Trunk Access Code page appears. Enter the extra digits that
Cisco Unity must useto transfer callsthrough the gateway to extensions on the other phone systems with
which it isintegrated. Then click Next.

(Cisco Unity 4.2 and later only) On the Reassign Subscribers page, any subscribers whose phone system
integration has been deleted and who are not currently assigned to a phone system integration will appear
in the list.

If no subscribers appear in the list, click Next and continue to Step 13.

Otherwise, select the subscribersthat you want to assign to this phone system integration and click Next.
You can use the following selection controls for selecting subscribers.

Table 4 Selection Controls for the Reassign Subscribers Page

Selection Control Effect

Check All Checks the check boxes for all subscribersin the list.

Uncheck All Unchecks the check boxes for all subscribersin the list.

Toggle Selected For the subscribers highlighted in the list, toggles between checking and

unchecking the check boxes.

If some highlighted subscriber check boxes are checked and others are
unchecked, clicking this button will check all the check boxes. Clicking again
will uncheck all the check boxes.

(Cisco Unity 4.2 and later only) On the Reassign Call Handlers page, any call handlers whose phone
system integration has been deleted and that are not currently assigned to a phone system integration will
appear in the list.

If no call handlers appear in the list, click Next and continue to Step 14.

Otherwise, select the call handlers that you want to assign to this phone system integration and click
Next. You can use the following selection controls for selecting call handlers.

Table 5 Selection Controls for the Reassign Call Handlers Page

Selection Control Effect

Check All Checks the check boxes for all call handlersin the list.

Uncheck All Unchecks the check boxes for all call handlersin thelist.

Toggle Selected For the call handlers highlighted in the list, toggles between checking and

unchecking the check boxes.

If some highlighted call handler check boxes are checked and others are
unchecked, clicking this button will check all the check boxes. Clicking again
will uncheck all the check boxes.

On the Completing page, verify the settings you entered, then click Finish.
At the prompt to restart the Cisco Unity services, click Yes. The Cisco Unity services restart.

Alternatively, you can restart the Cisco Unity servicesin UTIM on the Tools menu by clicking Restart
Cisco Unity.

[ oL-5849-03
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Step 1
Step 2
Step 3
Step 4
Step 5

To Enter the Voice Messaging Port Settings for the Integration

After the Cisco Unity services restart, on the View menu, click Refresh.

In the left pane of the UTIM window, expand the phone system integration that you are creating.
In the left pane, click the name of the phone system.

In the right pane, click the Ports tab.

Enter the settings shown in Table 6 for the voice messaging ports.

For best performance, use the first voice messaging ports for incoming calls and the last portsto dial out.
This helps minimize the possibility of acollision, in which anincoming call arrives on aport at the same
time that Cisco Unity takes the port off-hook to dial out.

A

Caution  In programming the phone system, do not send calls to voice messaging portsin Cisco Unity
that cannot answer calls (voice messaging portsthat are not set to Answer Calls). For example,
if avoice messaging port is set only to Message Notification, do not send callsto it.

Table 6 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.
Uncheck this check box to disable the port. When the port is disabled, callsto the port get a
ringing tone but are not answered. Typically, the port is disabled only by the installer during
testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be incoming

calls from unidentified callers or from subscribers.

Message Notification

Check this check box to designate the port for notifying subscribers of messages. Assign
Message Notification to the least busy ports.

Dialout MWI

(not used by serial or SMDI to the least busy ports.
integrations)

Check this check box to designate the port for turning MWIson and off. Assign Dialout MWI

AMIS Delivery

(available with the AMIS
licensed feature only)

Check this check box to designate the port for making outbound AMIS callsto deliver voice
messages from Cisco Unity subscribers to users on another voice messaging system.

Cisco Unity supports the Audio Messaging I nterchange Specification (AMIS) protocol,
which provides an analog mechanism for transferring voice messages between different
Voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

Because the transmission of outgoing AMIS messages may tie up voice ports for long
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule
page so that outgoing AMIS calls are placed during closed hours or at times when

Cisco Unity is not processing many calls.

TRAP Connection

Check this check box so that subscribers can use the phone as a recording and playback
devicein Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the
least busy ports.

Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0
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Step 6
Step 7

Testing the Integration 1l

Click Save.
Exit UTIM.

Testing the Integration

Step 1

Step 2

Step 3

To test whether Cisco Unity and the phone system are integrated correctly, do the following procedures
in the order listed.

If any of the stepsindicate afailure, refer to the following documentation as applicable;
« Theinstallation guide for the phone system.

- Cisco Unity Troubleshooting Guide, available at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_troubleshooting_guides _list.html.

» The setup information earlier in this guide.

To Set Up the Test Configuration

Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Cisco Unity is
connected to.

Set Phone 1 to forward calls to the Cisco Unity pilot number when calls are not answered.

A

Caution  The phone system must forward calls to the Cisco Unity pilot number in no fewer than four
rings. Otherwise, the test may fail.

In the Cisco Unity Administrator, create a test subscriber to use for testing by doing the applicable
substeps below.

If your message store is Microsoft Exchange, do the following:

a. Inthe Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.
b. Click the Add icon.

c. Select New Exchange Subscriber.

d. Onthe Add Subscriber page, enter the applicable information.

e. Click Add.

If your message store is IBM Lotus Domino, do the following:

a. Inthe Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.
b. Click the Add icon.

Click Notes.

d. Inthe Address Book list, confirm that the address book listed is the one that contains the user data
that you want to import.

o

If the address book that you want to use is not listed, go to the System > Configuration >
Subscriber Address Books page and add a different address book.

e. Inthe Find Domino Person By list, indicate whether to search by short name, first name, or last
name.

[ oL-5849-03
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Step 4
Step 5
Step 6
Step 7

Step 8

Step 9
Step 10
Step 11

Step 12
Step 13
Step 14
Step 15

Step 1

Step 2
Step 3

Step 4

Step 5

f.  Enter the applicable short name or name. You also can enter * to display alist of all users, or enter
one or more characters followed by * to narrow your search.

g. Click Find.

h. Onthelist of matches, click the name of the user to import.
i. Onthe Add Subscriber page, enter the applicable information.
j. Click Add.

In the Extension field, enter the extension of Phone 1.

In the Active Schedule field, click All Hours - All Days.

Click the Save icon.

In the navigation bar, click Call Transfer to go to the Subscribers > Subscribers > Call Transfer page
for the test subscriber.

For more information on transfer settings, refer to the “ Subscriber Template Call Transfer Settings’
section in the Cisco Unity Administrator Help.

Under Transfer Incoming Calls, click Yes, Ring Subscriber’s Extension, and confirm that the extension
number is for Phone 1.

Under Transfer Type, click Release to Switch.
Click the Save icon.

In the navigation bar, click M essagesto go to the Subscribers > Subscribers > M essages page for the test
subscriber.

Under Message Waiting Indicators (MWIs), check Use MWI for M essage Notification.
In the Extension field, enter x.
Click the Save icon.
Open the Status Monitor by doing one of the following:
= InInternet Explorer, go to http://<Cisco Unity server name>/web/sm.
» Double-click the desktop shortcut to the Status Monitor.
« Inthe status bar next to the clock, right-click the Cisco Unity tray icon and click Status M onitor.

To Test an External Call with Release Transfer

From Phone 2, enter the access code necessary to get an outside line, then enter the number outside
callers use to dial directly to Cisco Unity.

On the Status Monitor, note which port handles this call.

When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting
means that the port is configured correctly.

Confirm that Phone 1 rings and that you hear aringback tone on Phone 2. Hearing aringback tone means
that Cisco Unity correctly released the call and transferred it to Phone 1.

Leaving Phone 1 unanswered, confirm that the state of the port handling the call changesto “Idle.” This
state means that release transfer is successful.

Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0
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Step 6

Step 7
Step 8
Step 9

Step 10

Step 1
Step 2

Step 3

Step 4
Step 5
Step 6

Step 7
Step 8

Step 1

Step 2
Step 3
Step 4

Testing the Integration 1l

Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded to
Cisco Unity and that you hear the greeting for the test subscriber. Hearing the greeting means that the
phone system forwarded the unanswered call and the call-forward information to Cisco Unity, which
correctly interpreted the information.

On the Status Monitor, note which port handles this call.
L eave a message for the test subscriber and hang up Phone 2.

On the Status Monitor, confirm that the state of the port handling the call changesto “Idle.” This state
means that the port was successfully released when the call ended.

Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system and
Cisco Unity are successfully integrated for turning on MWiIs.

To Test Listening to Messages

From Phone 1, enter the internal pilot number for Cisco Unity.

When asked for your password, enter the default password. Hearing the request for your password means
that the phone system sent the necessary call information to Cisco Unity, which correctly interpreted the
information.

Confirm that you hear the recorded voice name for the test subscriber (if you did not record a voice name
for the test subscriber, you will hear the extension number for Phone 1). Hearing the voice name means
that Cisco Unity correctly identified the subscriber by the extension.

When asked whether you want to listen to your message, press 1.
After listening to the message, press 3 to delete the message.

Confirm that the MWI on Phone 1 is deactivated. The deactivated MWI means that the phone system and
Cisco Unity are successfully integrated for turning off MWiIs.

Hang up Phone 1.

On the Status Monitor, confirm that the state of the port handling the call changesto “Idle.” This state
means that the port was successfully released when the call ended.

To Set Up Supervised Transfer on Cisco Unity

In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Call Transfer page.

If the name of the test subscriber is not displayed, click the Find icon (the magnifying glass) in thetitle
bar, then click Find, and select the name of the test subscriber in the list that appears.

For more information on transfer settings, refer to the “ Subscriber Template Call Transfer Settings”
section in the Cisco Unity Administrator Help.

Under Transfer Type, click Supervise Transfer.
Set the Rings to Wait For field to 3.
Click the Save icon.

[ oL-5849-03
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M Integrating a Secondary Server for Cisco Unity Failover

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7
Step 8

Step 1

Step 2
Step 3

To Test Supervised Transfer

From Phone 2, enter the access code necessary to get an outside line, then enter the number outside
callers use to dial directly to Cisco Unity.

On the Status Monitor, note which port handles this call.

When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting
means that the port is configured correctly.

Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you should
hear the indication your phone system usesto mean that the call ison hold (for example, music or beeps).

Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.” This
state and hearing an indication that you are on hold mean that Cisco Unity is supervising the transfer.

Confirm that, after three rings, you hear the greeting for the test subscriber. Hearing the greeting means
that Cisco Unity successfully recalled the supervised-transfer call.

During the greeting, hang up Phone 2.

On the Status Monitor, confirm that the state of the port handling the call changesto “Idle.” This state
means that the port was successfully released when the call ended.

To Delete the Test Subscriber

In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

If the name of the test subscriber is not displayed, click the Find icon (the magnifying glass) in thetitle
bar, then click Find, and select the name of the test subscriber in the list that appears.

In the title bar, click the Delete Subscriber icon (the X).
Click Delete.

Integrating a Secondary Server for Cisco Unity Failover

The Cisco Unity failover feature enables a secondary server to provide voice messaging services when
the primary server becomes inactive. For information on installing a secondary server for failover, refer
to the applicable Cisco Unity installation guide, available at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides list.html.

For information on failover, refer to the Cisco Unity Failover Configuration and Administration Guide.
The Domino version of the guide is available at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/dom/index.htm. The
Exchange version of the guide is available at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/ex/index.htm.
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Integrating a Secondary Server for Cisco Unity Failover [l

Requirements

The following components are required to integrate a secondary server:

» Onesecondary server for each primary server installed and ready for the integration, asdescribed in
the applicable Cisco Unity installation guide and earlier in this integration guide.

« Theapplicable cable configuration for each anal og voice messaging port to simultaneously connect
the phone system to the corresponding ports on both the primary and the secondary servers. For
example, connect port 1 on the phone system with both port 1 on the primary server and port 1 on
the secondary server.

« A license that enables failover.

Integration Description

The phone system communicates with both the primary and secondary servers through the connecting
cables. Figure 2 shows the required connections.

Figure 2 Connections Between the Phone System and Cisco Unity Servers
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Analog lines

The primary and secondary servers act in the following manner:
= When the primary server is operating normally, the secondary server isinactive.
» When the primary server becomes inactive, the secondary server becomes active.

« When the primary server becomes active again, the secondary server becomes inactive.

Setting Up the Secondary Server for Failover
Do the following procedure to integrate the secondary server.

To Set Up the Secondary Server for Failover

Step1 Install asecondary server with the same configuration asthe primary server. For installation instructions,
refer to the applicable Cisco Unity installation guide.

Step2  Makeall voice connections from the phone system to the corresponding ports on both the primary server
and the secondary server. For example, connect port 1 from the phone system with port 1 on both the
primary and the secondary servers.

Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0
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Step 3

Step 4

Step 5

Step 6

Step 7

Step 8
Step 9

Step 10
Step 11
Step 12

Step 13

On the Windows Start menu of the secondary server, click Programs > Cisco Unity > Manage
Integrations. The UTIM window appears.

On the Integration menu of the UTIM window, click New. The Telephony Integration Setup Wizard
appears.

Enter the settings to match the integration settings on the primary server.

~

Note  We recommend not reassigning any unassigned subscribers and call handlers to the new
integration, if you are asked by the wizard. Failover replication will automatically assign the
correct integration.

At the prompt to restart the Cisco Unity services, click Yes.

~

Note  When restarting the Cisco Unity services, use the UTIM prompt instead of the Cisco Unity icon
in the Windows taskbar. The taskbar icon does not restart all of the Cisco Unity services.

After Cisco Unity restarts, on the Windows Start menu of the Cisco Unity server, click Programs >
Cisco Unity > Manage Integrations. UTIM appears.

In the left pane of the UTIM window, click the phone system integration that you created in Step 4.
For Cisco Unity 4.0 and 4.1, continue to Step 10.

For Cisco Unity 4.2 and later, do the following substeps.

a. Intheright pane, click Properties.

b. OntheIntegration tab, compare the setting of the Integration ID field for the secondary server to the
setting of the Integration ID field for the primary server.

c. If theintegration IDs of the phone system on the primary and secondary server are the same,
continue to Step 10.

If theintegration IDs of the phone system on the primary and secondary servers are different, on the
secondary server, click M odify Integration ID.

d. When cautioned that subscribers associated with the current Integration 1D setting will not be
automatically associated with the new Integration 1D setting, click OK.

e. IntheModify Integration ID dialog box, in the Enter New Integration 1D field, enter the Integration
ID setting for the phone system on the primary server and click OK.

f. Click Save.
g. At the prompt to restart the Cisco Unity services, click No.
h. Intheleft pane, click the phone system integration that you created in Step 4.
In the left pane, click the phone system integration you created.
In the right pane of the UTIM window, click the Ports tab.
Enter the port settings to match the port settings on the primary server.

A

Caution  In programming the phone system, do not send calls to voice messaging ports in Cisco Unity
that cannot answer calls (voice messaging portsthat are not set to Answer Calls). For example,
if avoice messaging port is set only to Dialout MWI, do not send calls to it.

Click Save.
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Step 14
Step 15
Step 16
Step 17
Step 18
Step 19
Step 20
Step 21
Step 22
Step 23

Step 24

Step 25

Step 26
Step 27
Step 28
Step 29
Step 30

Changing the Settings for an Existing Integration Il

Exit UTIM.

Click Programs > Cisco Unity > Edit Switch Utility.

In the Switch Configuration Editor window, in the Manufacturer field, click Avaya.
In the Model field, click Merlin 2.

Click Edit.

In the Switch Configuration dialog box, click the Incoming Calls tab.

Inthe Min. Ring on Timefield, enter 250.

In the Call Ringsfield, enter 1 and click OK.

In the Switch Configuration Editor dialog box, click Exit.

If you are using Cisco Unity version 4.0(4) or later and have not upgraded from an earlier version, skip
the remaining steps.

Otherwise, on the Windows Start menu, click Run.
Enter Regedit and click OK.

A

Caution  Changing the wrong registry key or entering an incorrect value can cause the server to
malfunction. Before you edit the registry, confirm that you know how to restoreit if a problem
occurs. (Refer to the “Restoring” topics in Registry Editor Help.) If you have any questions
about changing registry key settings, contact Cisco TAC.

If you do not have a current backup of the registry, click Registry > Export Registry File, and save the
registry settingsto afile.

Expand the key HKEY _LOCAL_MACHINE\Software\Active Voice\Miu\1.0\Initialization.
Double-click New Call Delay on Inactive Backup Server.

In the Edit DWORD Value dialog box, in the Value Data field, enter 15000 (decimal), and click OK.
Close the Registry Editor.

Restart the Cisco Unity server.

No changes to the hunt group programming on the phone system are necessary.

Changing the Settings for an Existing Integration

Step 1

Step 2
Step 3

After the integration is set up, if you want to change any of its settings (for example, to add or remove
voice messaging ports for an integration), do the following procedure.

To Change the Settings for an Integration

On the Cisco Unity server, on the Windows Start menu, click Programs > Cisco Unity > Manage
Integrations. The UTIM window appears.

In the left pane, double-click Unity Server. The existing integrations appear.
Click the integration you want to modify.

[ oL-5849-03
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M Deleting an Existing Integration

Step 4

Step 5
Step 6

Step 7
Step 8

In the right pane, click the name of the cluster, phone system, or PIMG unit (depending on your
integration) for the integration.

In the right pane, click the applicable tab for the integration.
Enter new settings in the fields that you want to change.

A

Caution  If you are adding or removing voice messaging ports, make sure you change the settings for
theindividual ports so that there are an appropriate number of ports set to answer callsand an
appropriate number of ports set to dial out.

In the UTIM window, click Save.
If prompted, restart the Cisco Unity services.

Deleting an Existing Integration

Step 1

Step 2
Step 3
Step 4
Step 5

Step 6

Step 7

If you want to delete an existing integration (for example, you have replaced the phone system with
which Cisco Unity originally integrated), do the following procedure.

To Delete an Existing Integration

On the Cisco Unity server, on the Windows Start menu, click Programs > Cisco Unity > Manage
Integrations. The UTIM window appears.

In the left pane, double-click Unity Server. The existing integrations appear.
Click the integration that you want to delete.
On the Integration menu, click Delete.

Follow the on-screen instructions to assign the subscribers of the deleted phone system integration to
another phone system integration.

At the prompt to restart the Cisco Unity services, click Yes. The Cisco Unity services restart.

Alternatively, you can restart the Cisco Unity servicesin UTIM on the Tools menu by clicking Restart
Cisco Unity.

If the integration you deleted used voice cards, remove the voice cards from the Cisco Unity server.

Appendix: Using Alternate Extensions and MWIs
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Alternate Extensions

Alternate Extensions

In addition to the “primary” extension that you specify for subscribers, you can assign subscribers up to
nine alternate extensions. (The primary extension isthe one that you assign to each subscriber when you
create his or her subscriber account; it is listed on the Subscribers > Subscribers > Profile page.)

Reasons to Use Alternate Extensions

There are several reasonsthat you may want to specify alternate extensions for subscribers. For example,
if you have more than one Cisco Unity server that accesses a single, corporate-wide directory, you may
want to use alternate extensions to simplify addressing messagesto subscribers at the different locations.
With alternate extensions, the number that a subscriber uses when addressing a message to someone at
another location can be the same number that the subscriber dials when calling. You may also want to
use alternate extensions to:

- Handle multiple line appearances on subscriber phones.

» Offer easy message access on direct calls from a cell phone, home phone, or phone at an alternate
work site (assuming that the phone number is passed along to Cisco Unity from these other phone
systems). In addition, when such phones are used as alternate extensions, and are set to forward to
Cisco Unity, callers can listen to the subscriber greeting, and |eave messages for the subscriber just
as they would when dialing the primary extension for the subscriber.

Tip To reduce the number of requests from subscribers who want alternate extensions set up for
multiple cell phones, home phones, and other phones, give subscribers class of service (COS)
rights to specify their own set of alternate extensions. (See the Subscribers > Class of Service >
Profile page.) With proper COS rights, a subscriber can specify up to five alternate extensions
in the Cisco Unity Assistant—in addition to the nine that you can specify on the Subscribers >
Alternate Extensions page in the Cisco Unity Administrator.

« Enable URL-based extensions in Cisco Unity for an integration with a SIP phone system.

How Alternate Extensions Work

Before you set up alternate extensions, review the following list for information on how alternate
extensions work:

» Alternate extensions cannot exceed 30 characters in length. By default, each administrator-defined
alternate extension must be at least 3 charactersin length, while subscriber-defined alternate
extensions must be at least 10 characters.

You can use the Advanced Settings tool in Tools Depot to specify a minimum extension length for
the extensions entered in the Cisco Unity Administrator and the Cisco Unity Assistant. Refer to the
Advanced Settings Tool Help for details on using the settings. Respectively, the settings are
Administration—Set the Minimum Length for Locations, and Administration—Set the Minimum
Length for Subscriber-Defined Alternate Extensions.

» You can control whether subscribers can use the Cisco Unity Assistant to view the alternate
extensions that you specify in the Cisco Unity Administrator. To do so, see the Subscribers > Class
of Service > Profile page. The Subscriber-Defined Alternate Extension table displays the alternate
extensions that the subscriber adds.

[ oL-5849-03
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W Alternate Extensions

» Neither the Cisco Unity Administrator nor the Cisco Unity Assistant will accept an extension that
is already assigned to another subscriber (either as a primary or alternate extension), or to a public
distribution list, call handler, directory handler, or interview handler. Cisco Unity verifies that each
alternate extension is unigue—up to the dialing domain level, if applicable—before allowing either
an administrator or a subscriber to create it.

- All alternate extensions use the same transfer settings as the primary extension.

« In many cases, Cisco Unity can activate a message waiting indicator (MWI) for an alternate
extension. However, depending on the phones and phone systems involved, some additional phone
system programming may be required to set this up.

Setting Up Alternate Extensions

Step 1
Step 2

Step 3
Step 4

Step 1
Step 2

Step 3

Do the applicable procedure to add, modify, or delete alternate extensions:
- To Add Administrator-Defined Alternate Extensions, page 20
- To Modify or Delete Alternate Extension(s), page 20

To Add Administrator-Defined Alternate Extensions

In the Cisco Unity Administrator, go to any Subscribers > Alternate Extensions page.

In the Administrator-Defined Alternate Extensions table, enter an extension in any row. When entering
characters in the Alternate Extensions table, consider the following:

« You can enter an extension up to 30 characters in length. (SIP integrations can use up to 30
alphanumeric characters.)

» Each extension must be unique—up to the dialing domain level, if applicable.
« Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

» For SIPintegrations, you can also enter avalid alias for a SIP URL. For example, if the URL is
Sl P:aabade@cisco.com, enter aabade. Do hot use spaces.

» Rows are numbered as a convenience. You can enter alternate extensions in any order, and you can
have blank rows.

Repeat Step 2 as necessary.

Click the Save icon. Alternate extensions are enabled for all rows in the table.

To Modify or Delete Alternate Extension(s)

In the Cisco Unity Administrator, go to any Subscribers > Alternate Extensions page.

Do any of the following:
- To modify an extension, change the extension in the Alternate Extensions table.
» To delete extensions, check the check boxes next to the alternate extensions that you want to delete.
- Toremove all alternate extensions listed in the table, click Select All.

Click the Save icon.
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Step 4

Note

Alternate Mwis 1l

Repeat Step 2 and Step 3 as necessary.

You can run the Cisco Unity Bulk Import wizard when you want to add alternate extensions for multiple
subscribers at once. When you do, the Cisco Unity Bulk Import wizard appends the new alternate
extensions to the existing table of alternate extensions, beginning with the first blank row.

Alternate MWIs

You can set up Cisco Unity to activate alternate MWIs when you want a new message for a subscriber
to activate the MWIs at up to 10 extensions. For example, a message left at extension 1001 can activate
the MWIs on extensions 1001 and 1002.

Cisco Unity uses MWIs to alert the subscriber to new voice messages. MWIs are not used to indicate
new e-mail, fax, or return receipt messages.

Setting Up Alternate MWIs

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6

Cisco Unity can activate alternate MWIs. Note that depending on the phones and phone systems, some
additional phone system programming may be necessary. Refer to the installation guide for the phone
system.

To enable alternate MWIs for extensions, do the following procedure for each subscriber who needs
alternate MWIs.

To Set Up Alternate MWIs for Extensions

In the Cisco Unity Administrator, go to the applicable Subscribers > Subscribers > M essages page.
Confirm that the Use MW for M essage Notification check box is checked.

Click the Add button located beneath the MWI Extensions table to add a row to the table. By default,
the first row in the table contains an “ X" to indicate the primary extension assigned to a subscriber. If
you want one more extension and do not need to activate the MWI on the primary extension, you can
also modify the first row.

Enter the applicable extension in the Extension field of the table. MWIs are automatically enabled for
all rowsin the table. When entering characters in the MWI Extensions table, consider the following:

» Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.
- Enter, (comma) to insert a one-second pause.
» Enter # and * to correspond to the # and * keys on the phone.
Click the Save icon.
Repeat Step 3 through Step 5 as necessary.

[ oL-5849-03
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W Conventions

Note

Step 1
Step 2

Step 3
Step 4

You can run the Cisco Unity Bulk Import wizard when you want to set up alternate MWIs for multiple
subscribers at once.

To change or delete alternate MWIs for extensions, do the following procedure.

To Modify or Delete Alternate MWIs

In the Cisco Unity Administrator, go to the applicable Subscribers > Subscribers > M essages page.
Do either of the following:
- To modify an extension, change the extension in the MWI Extensions table.

» To delete extensions, check the check boxes next to the rows that you want to delete in the MWI
Extensions table, and then click the Delete button.

Click the Save icon.
Repeat Step 2 and Step 3 as nhecessary.

Appendix: Documentation and Technical
Assistance

Conventions

The Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0 uses the following conventions.

Table 7 Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0 Conventions
Convention Description
boldfaced text Boldfaced text is used for:

« Key and button names. (Example: Click OK.)

« Information that you enter. (Example: Enter Administrator in the User
Name box.)

<> Angle brackets are used around parameters for which you supply a value.

(angle brackets) (Example: In the Command Prompt window, enter ping <IP address>.)

) Hyphens separate keys that must be pressed simultaneously. (Example: Press
(hyphen) Ctrl-Alt-Delete.)
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~

Note

A

Obtaining Documentation 1l

Table 7 Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0 Conventions
Convention Description

> A right angle bracket is used to separate selections that you make:

(right angle « Onmenus. (Example: Onthe Windows Start menu, click Settings > Control
bracket) Panel > Phone and M odem Options.)

« Inthenavigation bar of the Cisco Unity Administrator. (Example: Go to the
System > Configuration > Settings page.)

[X] Square brackets enclose an optional element (keyword or argument). (Example:
(square brackets) [reg-e164])
[xX]v] Square brackets enclosing keywords or arguments separated by a vertical line

(vertical line) indicate an optional choice. (Example: [transport tcp | transport udp])

{x]y} Braces enclosing keywords or arguments separated by a vertical line indicate a
required choice. (Example: {tcp | udp})

(braces)

The Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0 also uses the following
conventions:

Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

Caution

Means reader be careful. In this situation, you might do something that could result in equipment
damage or loss of data.

For descriptions and URL s of Cisco Unity documentation on Cisco.com, see the About Cisco Unity
Documentation. The document is shipped with Cisco Unity and is available at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/about/aboutdoc.htm.

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several
ways to obtain technical assistance and other technical resources. These sections explain how to obtain
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL :
http://www.cisco.com/techsupport
You can access the Cisco website at this URL:
http://www.cisco.com
Avaya Merlin Legend DTMF Integration Guide for Cisco Unity 4.0
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W Documentation Feedback

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_|anguages.shtml

Product Documentation DVD

The Product Documentation DVD is a comprehensive library of technical product documentation on a
portable medium. The DV D enables you to access multiple versions of installation, configuration, and
command guides for Cisco hardware and software products. With the DV D, you have access to the same
HTML documentation that is found on the Cisco website without being connected to the Internet.
Certain products also have .PDF versions of the documentation available.

The Product Documentation DV D isavailable asasingle unit or as a subscription. Registered Cisco.com
users (Cisco direct customers) can order a Product Documentation DVD (product number
DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Ordering Documentation

Registered Cisco.com users may order Cisco documentation at the Product Documentation Store in the
Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. to 5:00 p.m.

(0800 to 1700) PDT by calling 1 866 463-3487 in the United States and Canada, or elsewhere by
calling 011 408 519-5055. You can also order documentation by e-mail at

tech-doc-store-mkpl @external .cisco.com or by fax at 1 408 519-5001 in the United States and Canada,
or elsewhere at 011 408 519-5001.

Documentation Feedback

You can rate and provide feedback about Cisco technical documents by completing the online feedback
form that appears with the technical documents on Cisco.com.

You can submit comments about Cisco documentation by using the response card (if present) behind the
front cover of your document or by writing to the following address:

Cisco Systems

Attn: Customer Document Ordering
170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:
http://www.cisco.com/en/US/products/products_security_vulnerability _policy.html
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Cisco Product Security Overview

From this site, you will find information about how to:
» Report security vulnerabilities in Cisco products.
- Obtain assistance with security incidents that involve Cisco products.
» Register to receive security information from Cisco.

A current list of security advisories, security notices, and security responses for Cisco productsis
available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real time, you
can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS)
feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products _psirt_rss_feed.html

Reporting Security Problems in Cisco Products

Ciscoiscommitted to delivering secure products. Wetest our productsinternally before werelease them,
and we strive to correct all vulnerabilities quickly. If you think that you have identified a vulnerability
in a Cisco product, contact PSIRT:

» For Emergencies only— security-al ert@cisco.com

An emergency is either acondition in which a system isunder active attack or a condition for which
a severe and urgent security vulnerability should be reported. All other conditions are considered
nonemergencies.

» For Nonemergencies— psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:
- 1877 228-7302
- 1408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuPG) to
encrypt any sensitiveinformation that you send to Cisco. PSIRT can work with information that has been
encrypted with PGP versions 2.x through 9.x.

Never use arevoked or an expired encryption key. The correct public key to usein your correspondence
with PSIRT isthe one linked in the Contact Summary section of the Security Vulnerability Policy page
at this URL:

http://www.cisco.com/en/US/products/products_security vulnerability policy.html

The link on this page has the current PGP key ID in use.

If you do not have or use PGP, contact PSIRT at the af orementioned e-mail addresses or phone numbers
before sending any sensitive material to find other means of encrypting the data.
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Obtaining Technical Assistance

Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco
Technical Support & Documentation website on Cisco.com features extensive online support resources.
In addition, if you have avalid Cisco service contract, Cisco Technical Assistance Center (TAC)
engineers provide telephone support. If you do not have a valid Cisco service contract, contact your
reseller.

Cisco Technical Support & Documentation Website

The Cisco Technical Support & Documentation website provides online documents and tools for
troubleshooting and resolving technical issues with Cisco products and technologies. The website is
available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com user
ID and password. If you have avalid service contract but do not have a user ID or password, you can
register at this URL :

http://tools.cisco.com/RPF/register/register.do

Note  Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting
aweb or phone request for service. You can access the CPI tool from the Cisco Technical Support &
Documentation website by clicking the Tools & Resources link under Documentation & Tools. Choose
Cisco Product Identification Tool from the Alphabetical Index drop-down list, or click the Cisco
Product Identification Tool link under Alerts & RMASs. The CPI tool offers three search options: by
product ID or model name; by tree view; or for certain products, by copying and pasting show command
output. Search results show an illustration of your product with the serial number label location
highlighted. Locate the serial number label on your product and record the information before placing a
service call.

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and $4 service requests. (S3
and $4 service requests are those in which your network is minimally impaired or for which you require
product information.) After you describe your situation, the TAC Service Request Tool provides
recommended solutions. If your issue is not resolved using the recommended resources, your service
request is assigned to a Cisco engineer. The TAC Service Request Tool islocated at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telephone.
(S1 or S2 service requests are those in which your production network is down or severely degraded.)
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447
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For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has established severity
definitions.

Severity 1 (S1)—An existing network is down, or thereis a critical impact to your business operations.
You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your
business operations are negatively affected by inadequate performance of Cisco products. You and Cisco
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network isimpaired, while most business operations
remain functional. You and Cisco will commit resources during normal business hoursto restore service
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or
configuration. Thereislittle or no effect on your business operations.

Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available from various online
and printed sources.

» The Cisco Product Quick Reference Guide is a handy, compact reference tool that includes brief
product overviews, key features, sample part numbers, and abbreviated technical specifications for
many Cisco products that are sold through channel partners. It is updated twice ayear and includes
the latest Cisco offerings. To order and find out more about the Cisco Product Quick Reference
Guide, go to this URL:

http://www.cisco.com/go/guide

» Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo
merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

» Cisco Press publishes awiderange of general networking, training and certification titles. Both new
and experienced users will benefit from these publications. For current Cisco Press titles and other
information, go to Cisco Press at this URL:

http://www.ciscopress.com

- Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and
networking investments. Each quarter, Packet delivers coverage of the latest industry trends,
technology breakthroughs, and Cisco products and solutions, as well as network deployment and
troubleshooting tips, configuration examples, customer case studies, certification and training
information, and links to scores of in-depth online resources. You can access Packet magazine at
this URL:

http://www.cisco.com/packet
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M Obtaining Additional Publications and Information

» iQ Magazine isthe quarterly publication from Cisco Systems designed to help growing companies
learn how they can use technology to increase revenue, streamline their business, and expand
services. The publication identifies the challenges facing these companies and the technol ogies to
help solve them, using real-world case studies and business strategies to help readers make sound
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/igmagazine
or view the digital edition at this URL:
http://ciscoiq.texterity.com/ciscoig/sample/

« Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering
professionals involved in designing, developing, and operating public and private internets and
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

» Networking products offered by Cisco Systems, as well as customer support services, can be
obtained at this URL :

http://www.cisco.com/en/US/products/index.html

» Networking Professionals Connection isan interactive website for networking professionalsto share
guestions, suggestions, and information about networking products and technol ogies with Cisco
experts and other networking professionals. Join a discussion at this URL :

http://www.cisco.com/discuss/networking

» World-class networking training is available from Cisco. You can view current offerings at
this URL:

http://www.cisco.com/en/US/learning/index.html

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and
figuresincluded in the document are shown for illustrative purposes only. Any use of actual |P addresses in illustrative content is unintentional and
coincidental.

© 2006 Cisco Systems, Inc. All rights reserved.
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